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The Measure Serial Control User Manual describes how to install, set
up, and use the Measure Serial Add-In for controlling serial
instruments. This manual gives you specific information about using
the Serial Add-In with Microsoft Excel.

Organization of This Manual
The Measure Serial Control User Manual is organized as follows.

• Chapter 1, Introduction, describes the procedures for installing and
uninstalling Measure for Windows and for adding and removing
the Serial Add-In.

• Chapter 2, Getting Started with Serial Tasks, explains how to get
started with serial tasks.

• Chapter 3, Serial Task Reference, describes and outlines
procedures for using every menu and dialog box available in the
Serial Add-In.

• Chapter 4, Using Measure Serial Tasks with VBA, describes the
functions that the Serial Add-In adds to Visual Basic for
Applications (VBA), the programming language built into
Microsoft Excel.

• Chapter 5, Serial Technical Reference, lists technical information
about the Serial Add-In.

• Appendix A, Serial Connector Pinouts, lists the pin assignments of
common serial connectors.

• Appendix B, Error Messages, describes the errors that can be
encountered while using the Serial Add-In.
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• Appendix C, Troubleshooting, provides help for some common
problems encountered when working with serial instruments.

• Appendix D, Customer Communication, contains forms to help
you gather the information necessary to help us solve technical
problems you might have as well as a form you can use to
comment on the product documentation.

• The Glossary contains an alphabetical list and description of terms
used in this manual, including abbreviations, acronyms, metric
prefixes, mnemonics, and symbols.

• The Index contains an alphabetical list of key terms and topics in
this manual, including the page where you can find each one.

Conventions Used in This Manual
The following conventions are used in this manual:

bold Bold text denotes a parameter, or the introduction of menus, menu
items, or dialog box buttons or options.

italic Italic text denotes emphasis, a cross reference, or an introduction to a
key concept.

bold italic Bold italic text denotes a note, caution, or warning.

monospace Text in this font denotes text or characters that are to be literally input
from the keyboard, sections of code, programming examples, and
syntax examples. This font is also used for the proper names of disk
drives, paths, directories, programs, subprograms, subroutines, device
names, functions, variables, filenames, and extensions, and for
statements and comments taken from program code.



About This Manual

© National Instruments Corporation xi Measure Serial Control User Manual

» The » symbol leads you through nested menu items, and dialog box
options to a final action. The sequence

Files»Page Setup»Options»Substitute Fonts

directs you to pull down the File menu, select the Page Setup item,
select Options, and finally select the Substitute Fonts option from the
last dialog box.

Note: This icon to the left of bold italicized text denotes a note, which alerts
you to important information

Related Documentation
The following documents contain information that you might find
helpful as you read this manual:

• Campbell, Joe. The RS-232 Solution: How to Use Your Serial Port.
2nd edition. San Francisco: Sybex. 1989.

Customer Communication
National Instruments wants to receive your comments on our products
and manuals. We are interested in the applications you develop with
our products, and we want to help you if you have problems with them.
To make it easy for you to contact us, this manual contains comment
and technical support forms for you to complete. These forms are in
Appendix D, Customer Communication, at the end of this manual.
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Introduction

This chapter describes the procedures for installing and uninstalling
Measure for Windows, and for adding and removing the Serial Add-In.

Installing Measure

If you have already installed Measure for Windows and want to add the
Serial Add-In, skip below to the section Manually Adding or Removing
the Serial Add-In.

Otherwise, to install Measure for Windows, insert the installation disk
and run a:\setup.exe  from the taskbar in Windows 95 or from the
Program Manager for other versions of Microsoft Windows. Use the
setup program to install the Data Acquisition Add-In, the Serial
Add-In, the GPIB Add-In, or any combination of the three add-ins.

The setup program stores all the necessary files in a directory you
specify and installs Measure as an Excel add-in.

Manually Adding or Removing the Serial Add-In
To add the Serial Add-In manually, complete the following steps.

1. Start Excel and select Tools»Add-Ins... which brings up the Serial
Add-Ins dialog box, shown in Figure 1-1.

2. Click on the Browse button, and select the path where the setup
program installed Measure. The default directory is measure .

3. Type serial.xla in the File Name edit box, and press Enter.
The item Measure Serial Add-In  appears in the list box.

4. Click on OK  to close the Add-Ins dialog box.
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You also can remove the Serial Add-In manually. To do so, complete
the following steps.

1. From the Serial Add-Ins dialog box, shown in Figure 1-1, click on
the checkbox next to the item Measure Serial Add-In.

2.  When you have removed the check mark, click on OK  to close the
dialog box.

Figure 1-1. Serial Add-Ins Dialog Box

Uninstalling Measure

To uninstall Measure, complete the following steps.

1.  Select Uninstall from the Measure program group.

2.  Remove the Serial Add-In, the Data Acquisition Add-In, and the
GPIB Add-In from the Add-Ins list in Excel, as shown in
Figure 1-1.

3.  Delete the entire directory in which Measure was installed. The
default directory is measure .
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Getting Started with Serial
Tasks

This chapter explains how to get started with serial tasks. It describes
instruments, tasks, and how the Serial Add-In of Measure for Windows
allows you to communicate from MS Excel to instruments connected to
a serial (COM) port of your computer. Measure sends commands and
data to your instruments, and reads data from your instruments, and
stores it in a spreadsheet.

In Measure, you communicate with serial devices by creating tasks.
You can define one or more tasks for each instrument. Once you have
created a task, you can run it from the Serial Tasks dialog box, from
the Serial menu, or from any Visual Basic for Applications (VBA)
code.

Throughout this chapter, examples and step by step instructions are
given to help you get started with serial tasks.

Measure adds eight VBA functions to Microsoft Excel, allowing more
sophisticated communications between your computer and the serial
port device. For more information about those functions, see Chapter 4,
Using Measure Serial Tasks with VBA.

Instruments

In Measure, an instrument is a name given to the serial port settings
that allow interaction with a real instrument. You must set up these
serial port settings before interaction is possible. You set up an
instrument from the Instruments dialog box which is accessed by
selecting Serial»Instruments.

After configuring an instrument, you can create tasks to interact with
the instrument. Before using any real instrument with Measure, consult
the manual for that instrument for instructions on its proper use.

The sections below present two examples of setting up and collecting
data from an instrument.
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Example— Configure the Fluke 45 Multimeter

This example shows how to set up a Fluke 45 Multimeter to work with
Measure. The Fluke 45 Multimeter measures electrical characteristics
like AC\DC voltage. Follow the steps in this example as a tutorial for
Measure Serial Control. The workbook containing the example is
distributed with Measure as file fluke45.xls .

To set up the Fluke 45 Multimeter, complete the following four steps.

1. Select Serial»Instruments to show the Serial Instrument Setup
dialog box, shown in Figure 2-1.

2. Click on the New button and type the name of the instrument,
Fluke 45 .

3. Select the COM port for the Fluke 45 Multimeter from the Com
Port list box in the section for Port Setup.

4. Select the appropriate communications settings. The Fluke 45
operates at 2400 baud, No parity, 8 data bits, 1 stop bit, and no
flow control.

The Serial Instrument Set up for the Fluke 45 Multimeter should
appear as shown in Figure 2-1.

Figure 2-1. Serial Instrument Setup Dialog Box
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Example— Test the Instrument Connection

After setting up the instrument, you can test that the instrument is
connected and set up properly from the Instrument Set up dialog box.

1. Press the Test button to display the Instrument Test dialog box,
shown in Figure 2-2. From this dialog box, you can send
commands to the instrument and view its response.

2. In the Transmit field, type val1?  and press Enter.

3. The Fluke 45 Multimeter should respond with the current voltage
reading. If no response appears from the instrument, try clicking
on the Read Serial Port button to read the port again. Of course, if
you are just following these steps as a tutorial and do not actually
have a Fluke 45 Multimeter, there will not be any response. If you
do have the Fluke 45 Multimeter, and the instrument still does not
respond within a few seconds, refer to Appendix C,
Troubleshooting.

4.  Close the Instrument Test dialog box, by clicking on the OK
button.

The Serial Instrument Test dialog box should appear as shown in
Figure 2-2.

Figure 2-2. Testing the Fluke 45



Chapter 2    Getting Started with Serial Tasks

Measure Serial Control User Manual 2-4 © National Instruments Corporation

Tasks

Operations performed on instruments are called tasks. There are two
types of tasks: capture tasks and transmission tasks. Before you create a
task, you must configure an instrument. To create a task, complete the
following steps.

1.  Select Serial»Tasks to open the Tasks dialog box.

2.  Select the correct instrument from the Instrument drop-down box,
and click on the New Capture or New Transmit button to open a
dialog box to set up the task you want Measure to perform.

Capture Tasks

A capture task reads data from an instrument, parses the data into
fields, and stores the data in a spreadsheet range.

A capture task is a repeating process that reads data from an
instrument, parses the data into fields, and stores the data in a
spreadsheet range. When a capture task begins, the following steps
occur.

1.  If the corresponding checkbox is set, the serial input buffer is
cleared.

2.  If an Initialization command is given, Measure sends it to the
instrument.

A capture task is complete when each of the following steps occurs
once for each row in the spreadsheet range.

3.  If a command string is given, Measure sends it to the instrument.

4.  Measure reads data from the instrument. If fields are defined for
the data, the data is parsed into fields. If an end-of-line string is
defined for the data, Measure continues to step 3 when the end-of-
line string is encountered. If no end-of-line string is defined,
Measure continues to step 3 when all the defined fields are read.
Delimiting characters take precedence over end-of-line strings. If
no end-of-line string is defined and no fields are defined, but you
have specified a range to store the results, Measure waits for a
Carriage Return (\13) or Line Feed (\10) signal from the device.
When any of these standard termination characters are
encountered, Measure puts all data before the termination
characters in the specified worksheet cell, and throws away the
termination characters.
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5.  The received data is stored in the current row of the given range. If
the data was parsed into fields, each field is stored in one column
of the current row. If no fields are defined, all received data is put
in the first column of the current row. If no range is given, any
data received is ignored.

6.  If a response string is given, Measure sends it to the instrument.

7.  If a delay is given, Measure waits the given number of
milliseconds before continuing.

8.  The sequence starts again at step 3, using the next row in the range
to store the captured data. The task finishes when all rows in the
range are used, or no range is given.

If no range is given, Measure executes the sequence one time, and
ignores any data received from the instrument. This is a convenient
way to send simple commands to the instrument.

Fields

When an instrument reads data using a capture task, often it is useful to
parse the data and separate it into fields. A capture task allows you to
parse captured data using delimiters (such as commas or semicolons) or
by defining the width of each field. If no fields are defined, Measure
places all data received into one cell before the end-of-line string is
encountered.

Capture Tasks can parse with a delimiter you define, a particular width
you define, or the default delimiter.

Parsing by Custom–defined Delimiters

Assume you have an instrument that returns a measurement of two
coordinates, x and y. The instrument returns a string of the form
x,y\13\10 , where x  and y  each can be from 1 to 5 digits. In this
case, the best parsing method is to use delimiters. A solution is to
create two fields. The first field has a comma as a delimiter, and the
second field has \13\10  as its delimiter. In this case, no end-of-line
characters are used because the fields you defined completely define
the data sent by the instrument.
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Parsing by Width

When an Ohaus scale is asked for its current weight, it responds with a
20 character string of the following format:

Field Polarity Weight Blank Mode Stability Address Cr/Lf

Length 1 8 1 5 1 2 2

Picking out the weight field from this string is accomplished by parsing
by width because you know the location and width of the data you
want. There are several solutions. One solution is to create two fields,
the first field being one character wide and the second field being eight
characters wide. Additionally, the end-of-line character must be set to
\13\10 to indicate the end of a string. All characters between the weight
field and \13\10 are thrown away because no fields were defined for
them. Another solution is to define three fields, the first field being one
character wide, the second field being eight characters wide, and the
third field being eleven characters wide. In this case, no end-of-line
characters are necessary, because the string returned from the scale is
20 characters wide.

Parsing by the Default Delimiter

Using the default delimiter you can parse data into more fields than
originally were defined. The default delimiter is especially useful when
an instrument sends multiple fields delimited by the same delimiter.
For example, data of the form x1, x2, x3, x4, x5, x6, x7,
x8, x9, x10  could be parsed in two ways. For example, you could
create 10 fields, all delimited by commas. A simpler solution, however,
would be to create no fields at all, but to set the default delimiter to a
comma.

Notice the difference in the way Measure parses the data using each of
the two solutions. In the first solution, when you create 10 fields,
Measure reads 10 fields from the instrument, no matter how many
columns in the range you provide to store the result. If an end of line
character is encountered before all 10 fields are read, Measure stops
reading the current row and continues with the next row. In the second
solution, however, when you use a default delimiter, Measure
continues to read fields for the current row until an end of line
character is encountered or data for every column in the range has been
read.
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Transmission Tasks

A transmission task reads data from a spreadsheet range and sends the
data to an instrument.

A transmission task is a repeating process that reads data from a
spreadsheet and sends it to an instrument. When a transmission task
begins, the following steps occur.

1.  If the corresponding checkbox is set, the serial input buffer is
cleared.

2.  If an Initialization command is given, Measure sends it to the
instrument.

A transmission task is complete when each of the following steps
occurs once for each row in the spreadsheet range.

3.  If a command string is given, Measure sends it to the instrument.

4.  The data from the first column of the current row of the range is
sent to the instrument. If no range is given, this step is skipped.

5.  If an end-of-line string is given, Measure sends an end-of-line
string to the instrument.

6.  If a response string is given, Measure waits for the instrument to
send the response string.

7.  If a delay is given, Measure waits the given number of
milliseconds before continuing.

8.  The sequence starts again with step 3, using the next row in the
range. The sequence completes when all rows in the range are
used, or no range is given.

9.  If a repeat count is given, steps 3-8 are repeated the given number
of times.

If no range is given, Measure executes the sequence one time, and
ignores any data received from the instrument. This is a convenient
way to send simple commands to the instrument.

Example—Create an Instrument Capture Task

Now that you have configured and tested the instrument, you can
create the necessary tasks. In this example, create a task to switch the
multimeter to Volts DC mode. You can create either a capture task or a
transmission task. In this case, complete the following steps to create a
capture task.
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1. Select Serial»Tasks.

2. Select Fluke 45 from the Instrument  drop-down list.

3.  Click on the New Capture button, and the Capture Task dialog
box appears, shown in Figure 2-3.

4. Type Switch to Volts DC  in the Task Name field.

5. Type vdc\13  in the Transmit this command string field.

6. Type =>\13\10  in the Wait for this end-of-line string field.

7.  Click on the OK  button to close this dialog box, shown in
Figure 2-3.

Figure 2-3. Capture Task Dialog Box for Creating a Switch to Volts Task
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Example—Create an Instrument Read Task

Now, complete the following steps to create a task to capture the data.

1. Click on the New Capture button, and the Capture Task dialog
box appears, shown in Figure 2-4.

2. Type Read in the Task Name field.

3. Type val1?\13  in the Transmit this command string field.

4. Type a1:a10  in the Store the result in this range field.

5. Type \13\10=>\13\10  in the Wait for this end-of-line string
field.

6. Type 1000  in the Delay before restarting sequence field.

7.  Click on the OK  button to close this dialog box.

Figure 2-4. Capture Task Dialog Box for Creating a Read Task
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Example—Run Your Serial Tasks

Two tasks are defined now from examples 1 and 2, Switch to Volts DC
and Read.

To run the tasks from the Tasks dialog box, complete the following
steps.

1. Highlight Switch to Volts DC  and click on Run to run the
task that tells the multimeter to measure volts DC.

2. Highlight Read and click on Run to run the task that reads 10
values from the multimeter.

3. When the Read task is finished, Measure copies the data received
into the range a1:a10 .

4. Click on OK  to close the dialog box.

To run the tasks using VBA, complete the following steps.

1. Close the Tasks dialog box by clicking on OK .

2. Select Macro from the Insert menu in Excel.

3. Select Module from the popup menu that appears.

4.  Type the following code in the module, as shown in Figure 2-5.

Sub Sample()

Dim result as integer

result = Application.Run (“Serial”, “Switch to

Volts DC”)

result = Application.Run (“Serial”, “Read”)

End Sub

Your computer screen should appear as shown in Figure 2-5.
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Figure 2-5. VBA code to read data from the Fluke 45

5. Select Tools»Macro.

6. Select Sample from the list box.

7.  Click on Run to execute the subroutine.

8.  Click on the tab at the bottom of the screen corresponding to the
worksheet you were on when you added the module, as shown in
Figure 2-5.

9. The data is in the range a1:a10  on the worksheet.

Example—Add Tasks to the Serial Menu

You can add tasks that are run often to the Serial menu. To add a task
to the menu, complete the following steps.

1.  Select Serial»Tasks.

2.  Click on the Edit Menu  button to display the Edit Menu Tasks
dialog box. Use this dialog box to add or remove tasks. When both
the Edit Menu Tasks and the Tasks dialog boxes are closed using
their OK  buttons, the tasks are added under the Serial menu.

3.  To run a task, select it from the menu. When running tasks from
the menu, the current selection on the spreadsheet is used as the
range of the task. If there is no selection on the active spreadsheet,
the range specified in the dialog box is used.
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Communication Strings

When communicating with serial instruments, it often is necessary to
specify characters that are difficult to print. A good example is the
carriage-return character (ASCII 13). For this reason, anytime a string
is requested in a text box, Measure accepts a special sequence of
characters to specify unprintable characters. The sequence consists of a
backslash (\)  followed by up to three numbers representing the base10
ASCII value of the character. For instance, the carriage-return
character (ASCII 13) is represented by the string \13  or \013 . To
specify the common carriage-return line-feed pair, use the string
\13\10 . To specify the backslash character, use \\ . For example, the
string \\\13  specifies a backslash and a carriage-return, while \\13
specifies a backslash followed by a 1 and a 3.
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Serial Task Reference

This chapter describes and outlines procedures for using every menu
and dialog box available in the Serial Add-In.

Serial Instrument Setup Dialog Box

Use the Serial Instrument Setup dialog box to configure the
communication parameters of instruments that are used with Measure.

You can reach this dialog box by either selecting Serial»Instruments
or clicking on the Edit Instruments button from the Tasks dialog box.
Figure 3-1 shows the Serial Instruments Setup dialog box.

Figure 3-1. Serial Instrument Setup Dialog Box
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The Instruments list box contains an entry for each instrument defined
in Measure. The controls in the Port Setup group box apply to the
instrument currently selected in the list box. Table 3-1, Serial
Instruments Setup Options, provides a description of all the options
available from the Serial Instruments dialog box.

Table 3-1. Serial Instrument Setup Options

Option Description

New Adds a new instrument. The maximum number of instruments is 50.

Delete Deletes the currently selected instrument.

Test Tests communications with the instrument.

Com Port Sets the communications port that the instrument is connected to. The
default setting is COM 1. The communications port is usually either 1 or
2, although any number between 1 and 32767 can be entered.

Baud Rate Sets the baud rate (the speed of data transmission) for asynchronous
communications. The baud rate roughly equals the number of bits
transmitted per second. The baud rate that you select must match the baud
rate of the other computer or device for communications to occur. Choices
for the baud rate are 110, 300, 600, 1200, 2400, 4800, 9600, 14400,
19200, 38400, 56000, 128000, and 256000. The default baud rate is 2400.

Parity Selects the type of error-checking parity scheme to be used during
communications. Parity is an optional feature that helps ensure that
devices do not miss information that is sent or received. Parity checking is
accomplished by sending an additional bit with the data, called the parity
bit. The parity bit can be either one or zero, depending on the data and the
parity setting. Parity between the computer and the device must match.
The parity can be None, Even , Odd,  Space , or Mark.

Data Bits Selects the length of the data word. The number of bits or length of a data
word is specific to each device. Check the documentation of the device to
find the length of the data word it sends. The default number of data bits is
7. The number of data bits must be 5, 6, 7, or 8.

Stop Bits Selects the number of stop bits for a data word. Stop bits are the additional
bits that follow each data byte, signaling the end of the byte. The default
number of stop bits is 1. The stop bits field must be either 1, 1.5, or 2.

Flow
Control

Flow control is a means of regulating the flow of data between devices. It
allows communications to occur between devices that process data at
different rates. Hardware flow control uses pins in the serial interface to
control and monitor data flow. Software flow control uses a special
character to cause the sender to pause sending data and a different
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Flow
Control
(continued)

character to cause the sender to resume sending data. The flow control
setting must match the flow control that the instrument implements. For
hardware flow control, be sure that the pin connections are correct for the
two devices. Refer to Appendix A for additional information. For more
flow control options, see the Advanced Setup dialog box.

Advanced
Setup

Opens the Advanced Setup dialog box, which allows you to setup flow
control, buffer size, parity error, and lag features.

Instrument Test Dialog Box

Use the Instrument Test dialog box to test communications between
Measure and the instrument.

You can reach this dialog box, shown in Figure 3-2, by clicking on the
Test button on the Instrument Setup dialog box.

Figure 3-2. Instrument Test Dialog Box

Data typed in the Transmit edit box is sent to the instrument when you
click on the Send Data button or press the Enter key while the cursor is
in the Transmit edit box. If you press the Enter key, Measure sends the
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text in the Transmit edit box along with the carriage-return/ line-feed
string \13\10 to the instrument.

After transmitting the data, Measure waits for about 1 second, then
displays any data received from the instrument in the Receive edit box.
Occasionally, the instrument takes more than 1 second to respond. In
that case, press the Read Data button to query the instruments for data
again.

Table 3-2, Instrument Test Options, provides a description of all the
options available from the Serial Instruments Setup dialog box.

Table 3-2. Instrument Test Options

Option Description

Transmit edit
box

Type the text to send to the instrument in this edit box. When you press
the Enter key, Measure sends the text in this edit box along with a
carriage return/linefeed string \13\10 to the instrument. Measure then
waits about 1 second, reads the serial port, and puts the results in the
Receive edit box. If the instrument takes longer than 1 second to
respond, click on the Read Serial Port button to read the data from the
instrument.

Receive edit
box

When data is read from the instrument, Measure puts it here. Typing in
this edit box has no effect.

Send Data Sends the data in the Transmit edit box. Measure sends the data, waits
about 1 second, reads the serial port, and puts the results in the Receive
edit box.

Read Serial
Port

Forces Measure to read any data available from the instrument.. The
data is added to the data in the Receive edit box

Note: The Receive edit box displays only the first 255 characters received.

Advanced Instrument Setup Dialog Box

Use the Advanced Instrument Setup dialog box to configure advanced
communications parameters for an instrument.

You can reach this dialog box, shown in Figure 3-3, by clicking on the
Advanced Setup button from the Serial Instrument Setup dialog box.
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Figure 3-3. Advanced Instrument Setup Dialog Box

The options available from the Advanced Instrument Setup dialog box
are shown in Table 3-3.

Table 3-3. Advanced Instrument Setup Options

Option Description

Input Signals Determines which signals Measure drives to control the flow of data
from the instrument to the computer. If RTS is checked, Measure drives
RTS low when it wants the instrument to pause sending data, and drives
RTS high when it wants the instrument to continue sending data. The
DTR checkbox behaves in the same manner.

Output Signals Determines which signals Measure responds to when transmitting data
to the instrument using hardware flow control. If CTS is checked,
Measure sends data only when CTS is high. The DSR check box
behaves in the same manner. If they are both checked, Measure sends
data only when both CTS and DSR are high.

Software
Control

Specifies the character used to pause or resume the transfer of data
between Measure and the instrument when software flow control is in
use.

Flow Control
Points

Specifies at what point Measure asks the instrument to pause sending
data and at what point Measure asks the instrument to resume sending
data.
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Buffer Sizes Specifies the size of both the transmission buffer and the receive buffer.
Measure buffers characters sent to or received from the instrument. A
lower buffer size uses less memory.

Lag Causes Measure to wait the given number of milliseconds between the
transmission of successive characters. For example, when asked to
transmit the string 123 with a lag of 100 ms, Measure transmits a 1,
waits 100 ms, transmits a 2, waits 100 ms,... Time is accurate to
approximately 100 ms.

Parity Error
Character

Sets the parity error character. The character in this edit box is added to
the input buffer ahead of any characters which are received with parity
errors. For example, if the parity character is *  and the data returned
from the instrument is 123, Measure reads the string 1*23  if there is a
parity error reading the 2. If you do not want to use this feature, leave
this field blank. This edit box is only available if the instrument has a
parity setting other than None.

Tasks Dialog Box

Use the Tasks dialog box, shown in Figure 3-4, to manage tasks
associated with instruments. From this dialog box, you can create, run,
edit, or delete tasks. Also, you can use the Serial Instrument Setup
dialog box to edit instruments and the Menu Tasks dialog box to edit
the menu.
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Figure 3-4. Serial Port Tasks Dialog Box

The options available from the Serial Port Tasks dialog box are shown
in Table 3-4.

Table 3-4. Serial Port Task Options

Option Description

Instrument list
box

Contains all the instruments defined in Measure.

Tasks list box Contains all the tasks defined for the currently selected instrument.

Edit Instruments Edits the instruments defined in Measure.

Close Instrument Closes the instrument selected in the instrument list box

New Capture Creates a new capture task for the currently selected instrument.
There is a maximum of 200 tasks per instrument.
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New Transmit Creates a new transmit task for the currently selected instrument.
There is a maximum of 200 tasks per instrument.

Run Runs the currently selected task.

Edit Edits the currently selected task.

Delete Deletes the currently selected task.

Description Contains a description of the currently selected task.

Edit Menu Edits the list of tasks that appear on the Serial menu.

Capture Task Dialog Box

Use the Capture Task dialog box, shown in Figure 3-5, to edit capture
tasks. To reach this dialog box, click on New Capture from the Tasks
dialog box, or select a capture task on the Tasks dialog box and click
on the Edit button.

Figure 3-5. Capture Task Dialog Box

The options available from the Capture Task dialog box are shown in
Table 3-5.
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Table 3-5. Capture Task Dialog Box Options

Option Description

Task Name Type the task name here. No two tasks can have the same name.

Description The description appears in the Description field of the Tasks dialog box,
and if this task is added to the menu, the description appears on the
status bar when the task is selected. This field can be left blank.

Display status Determiones whether the Status dialog box while the task is running.
Measure displays the current progress of a running task on the status bar
regardless of the state of this checkbox.

Break on
parity errors

Determines how Measure responds when a parity error occurs during
communication. If checked, Measure stops the task and displays a
dialog box indicating that a parity error occurred. Otherwise, Measure
ignores parity errors while this task is running.

Clear Input
Buffer

Determines if Measure will ignore data peviously stored in an input
buffer. Measure stores data read from an instrument in an input buffer
until the data is read by taks. Specifies whether Measure should send a
Serial Clear command to the instrument before running the task.

Timeout Determines how long Measure will wait for an instrument to send data.
Setting the timeout to zero causes Measure to wait indefinitely. When
Measure executes a task, clicking on Q interrupts that task.

Command
string

Sets the command string is to be that sent to the instrument. This field
can be left blank. Refer to the section in Chapter 2 on communications
strings for help creating this string.

Result range Determines the range that a task uses. The data read from the instrument
is parsed into fields and stored in a row of this range. Measure executes
the task sequence once for each row in this range. If this field is left
blank, Measure executes this sequence once, ignoring any data that is
read from the instrument. Leaving the range blank is useful for sending
commands that set the instrument to a certain mode. See the section on
Ranges for help on specifying the range.

End-of-line
string

If no end-of-line string is defined, and no fields are defined, but you
have specified a range to store the results, Measure waits for a Carriage
Return (\13), or a Line Feed (\10) signal from the device. When any of
these standard termination characters are encountered, Measure places
all data before the termination characters in the specified worksheet cell,
and throws away the termination characters.
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Response
string

Sets the string that Measure sends to the instrument after the end-of-line
string is encountered or after all fields have been read if the end-of-line
string was not defined. This field can be left blank.

Delay  Determines how long Measure waits before starting the process again
with the next row in the range. Time is only accurate to approximately
100 ms.

Define Fields Open the Define Fields dialog box.

Transmission Task Dialog Box

Use the Transmission Task dialog box, shown in Figure 3-6, to edit
capture tasks. To reach this dialog box, click on New Transmit from
the Tasks dialog box, or select a transmit task on the Tasks dialog box
and click on the Edit  button.

Figure 3-6. Transmission Task Dialog Box
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The options available from the Transmission Task dialog box are
shown in Table 3-6.

Table 3-6. Transmission Task Dialog Box Options

Option Description

Task Name Type the task name here. No two tasks can have the same name.

Description Type a description of the task here. The description appears in the
Description field of the Tasks dialog box, and if this task is added to the
menu, the description appears on the status bar when this task is
selected. This field can be left blank.

Display status Determines if Measure displays the Status dialog box while the task is
running. Measure displays the current progress of a running task on the
status bar, regardless of the state of this checkbox.

Break on
parity errors

Determines how Measure responds when a parity error occurs during
communication. If checked, Measure stops the task and displays a
dialog box indicating that a parity error occurred. Otherwise, Measure
ignores parity errors while this task is running.

Clear Input
Buffer

Determines if Measure ignores data previously stored in an input buffer.
Specifies that Measure should send a Serial Clear command to the
instrument before running the task.

Timeout Determines how long Measure will wait for an instrument to send data.
Setting the timeout to zero causes Measure to wait indefinitely. When
Measure executes a task, clicking on Q interrupts the task.

Repeat Count Determines how many times Measure runs a task. For example, setting
the repeat count to 5 causes Measure to execute the task five times. If
the repeat count is 0, Measure runs the task indefinitely. When Measure
executes a task, clicking on Q interrupts the task.

Command
String

Sets the comand that will be sent to the instrument. This field can be left
blank. Refer to the section on communication strings for help in creating
this string.

Transmission
Range

Determines the range that a task uses. Measure executes the task
sequence once for each row in this range. If the range is blank, Measure
executes the sequence once. Leaving the range blank is useful for
sending commands that set the instrument to a certain mode. See the
Ranges section for help on specifying the range.

End-of-line
String

Marks the end-of-line of data sent to the instrument. This field can be
left blank. Refer to the section on Communication Strings for help
creating this string.



Chapter 3    Serial Task Reference

Measure Serial Control User Manual 3-12 © National Instruments Corporation

Response
String

Determines if Measure will wait for the instrument to respond with a
response string. The timeout value determines how long Measure waits
without signaling an error. If this field is blank, Measure skips this step
of the sequence. Refer to the section on communication strings for help
creating this string.

Delay Determines how long Measure waits before starting the process again
with the next row in the range. Time is accurate to approximately 100
ms.

Define Fields Dialog Box

Use the Define Fields dialog box, shown in Figure 3-7, to set up how
the Serial Add-In parses data using a capture task.

To reach this dialog box, click on the Define Fields button from the
Serial Capture Task dialog box.

Figure 3-7. Define Fields Dialog Box

The options available from the Define Fields dialog box are shown in
Table 3-7.
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Table 3-7. Define Fields Dialog Box Options

Option Description

Number of
Fields

Determines how many fields the data breaks into.

List Box Contains an entry for each field that has been defined.

Parsing
Method:

Width

If selected, Measure parses data into fields based on the width given for
each field.

Parsing
Method:

Delimiters

If selected, Measure parses data into fields based on the delimiter for
each field.

Default
Delimiters

Sets the delimiter Measure uses by default.

Field:

Delimiter

Sets the delimiter that Measure uses to determine the end of this field.

Field:

Width

Sets the width of the currently selected field.

Include Determines whether Measure should store the currently selected field in
the spreadsheet or ignore it once it is read.



© National Instruments Corporation 4-1 Measure Serial Control User Manual

Using Measure Serial Tasks
with VBA

This chapter describes the functions that the Serial Add-In adds to
Visual Basic for Applications (VBA), the programming language built
into Microsoft Excel.

Calling Functions from VBA

There are two ways to execute the VBA functions provided by the
Serial Add-In.

1. Use the Excel method Application.Run .

As long as the Serial Add-In is added as an add-in, the functions are
called using the following syntax.

result = Application.Run (“FunctionName”,

argument1, argument2, argument3, ...)

A few examples are listed below.

result = Application.Run(“Serial”, “Read some

data”, “sheet1!a1:a50”)

result =

Application.Run(“serial.xla!CloseInstrument”,

“MyInstrument”)

Application.Run “Serial”, “Read some data”

‘ Note: ignores return value

2. Add a reference to the Serial Add-In, then call the functions
directly.

To add a reference, you must have a module open instead of a
worksheet. To insert a new module, select Insert»Macro»Module.

To add a reference to the Serial Add-In, select Tools»References. Put a
check in the checkbox next to serial.xla , and click on OK .
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Now, the functions from the Serial Add-In are called directly, as in the
following examples.

result = RunTask(“Read some data”,

“sheet1!a1:a50”)

result = CloseInstrument(“MyInstrument”)

RunTask “Read some data” ‘ Note: ignores return

value

Note: The file ser_cons.txt  contains the constants returned by the Measure
VBA functions.

Serial Add-In Functions

The Serial Add-In defines the following eight functions that are called
from a VBA module.

• CloseInstrument

• FlushInputBuffer

• FlushOutputBuffer

• GetInputBufferLength

• GetMeasureError

• GetMeasureOpenError

• GetOutputBufferLength

• Serial

Each function is listed below with details of its use.
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CloseInstrument

Closes the specified instrument if it is open. This command has no effect if the
instrument is not open.

Syntax
Function CloseInstrument ( sInstrumentName as string) as  

Integer

Parameters
Parameter Name Description

sInstrumentName Name of the instrument to close.

Return Value
For a list of return values, see Table B-3, Measure VBA Return Values, in Appendix B,
Error Messages.

FlushInputBuffer

Clears all characters not already removed from the input buffer of the specified
instrument.

Syntax
Function FlushInputBuffer ( sInstrumentName As String) As 

Integer

Parameters
Parameter Name Description

sInstrumentName Name of the instrument.

Return Values
For a list of return values, see Table B-3, Measure VBA Return Values, in Appendix B,
Error Messages.
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FlushOutputBuffer

Clears all characters not already sent to the specified instrument yet.

Syntax
Function FlushOutputBuffer ( sInstrumentName As String) As 

Integer

Parameters
Parameter Name Description

sInstrumentName Name of the instrument.

Return Values
For a list of return values, see Table B-3, Measure VBA Return Values, in Appendix B,
Error Messages.

GetInputBufferLength

Returns the number of characters waiting to be read from the input buffer of the specified
instrument.

Syntax
Function GetInputBufferLength ( sInstrumentName As String) As 

Integer

Parameters
Parameter Name Description

sInstrumentName Name of the instrument.

Return Value
If positive, the number of characters waiting. If negative, see Table B-3, Measure VBA
Return Values, in Appendix B, Error Messages.
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GetMeasureError

This function should be called after a Measure function returns MEASURE_ERROR.

Syntax
Function GetMeasureError()  as Integer

Parameters
This function has not parameters.

Return Value
If there was no error, 0 is returned. Otherwise, Measure returns a combination of error
bits. For a list of return values, see Table B-1, Communication Return Values, in
Appendix B, Error Messages.

GetMeasureOpenError

This function should be called after a call to the Measure function RunTask  returns
MEASURE_OPENERROR.

Syntax
Function GetMeasureOpenError() As Integer

Parameters
This function has no parameters.

Return Value
If there was no error, 0 is returned. Otherwise, Measure returns a negative value. For a
list of possible return values, see Table B-2, Open Instrument Return Values, in
Appendix B, Error Messages.
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GetOutputBufferLength
Returns the number of characters waiting to be sent to the given instrument.

Syntax
Function GetOutputBufferLength ( sInstrumentName As String)

As Integer

Parameters
Parameter Name Description

sInstrumentName Name of the instrument.

Return Value
If positive, The buffer length is the number of characters waiting. If negative, see
Table B-3, Measure VBA Return Values, in Appendix B, Error Messages.

Serial
Executes the named task. If sRange  is not given, the default range of the task is used.
Otherwise, the given range is used.

Syntax
Function Serial ( sTaskName As String, Optional sRange As 

Variant, Optional ReferenceStyle as String) As
Integer

Parameters:
Parameter Name Description

sTaskName Name of the task to run

sRange String representing the range to use when running the task. sRange
should be of the form sheetname!a1:a50 , where sheetname!
is optional. If sRange is omitted, Measure uses the range defined for
the task in the dialog box.

ReferenceStyle Use either xlA1  or xlR1C1  to indicate the type of range address
being passed into sRange. If this parameter is missing, Excel’s
current reference type is assumed.

Return Value
For a list of return values, see Table B-3, Measure VBA Return Values, in Appendix B,
Error Messages.
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Serial Technical Reference

This chapter lists technical information about the Serial Add-In.

Closing the Serial Port

When you run a task is run, Measure opens the serial port and leaves it
open until one of the following events occurs.

1. You click on the Close Instrument button on the Serial Port Tasks
dialog box.

2. You close Measure or Excel.

3. You open the Setup Instruments dialog box.

4. The VBA function CloseInstrument  is called.

5. A task from another instrument using the same port is executed.

6. You switch workbooks from within Excel.

As long as the serial port is open, Measure buffers any data read from
the instrument, even if a task is not running.

Time

Although times are specified in milliseconds, the accuracy is only
approximately 100 ms. This increased delay is caused by the overhead
and latency of Windows, Excel, and VBA.
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Baud Rate and Character Format

The transmission speed of the Serial Add-In depends on the baud rate
setting you have selected. The baud rate is the number of bits per
second transferred through the serial port.

When setting the baud rate, it is helpful to consider the throughput, or
characters per second, for transmitted or received data. There are many
formats that a single character can have and the format of the character
determines how many bits are needed to describe it. To calculate
throughput, you need to know the format of the characters to be sent.
Characters are generally made up of four groups or sets of bits,
described in Table 5-1.

Table 5-1. Character Format Bits

Byte Position Number of Bits

Start bit always 1.

Parity bit 0 if no parity or 1 if any other parity setting.

Character bits 5, 6, 7, or 8 bits.

Stop bits 1, 1.5, or 2.

Once you determine the character length, you can use the following
equation to calculate the theoretical throughput for any baud rate.

Throughput (characters per second) = baud rate (bits / sec) / character
length (bits / character)

For example, at a baud rate of 2400 with a character length of 10 bits,
240 characters / second are transferred.

240 characters / sec = 2400 (baud) / 10 (bits / character)

The actual throughput can be less than the theoretical value depending
on a number of other transmission settings. Any of the following can
reduce the throughput rate.

• End-of-line string—Each time the end of a line is reached, the end-
of-line string is transmitted, adding to the total character count.

• Response Character—Measure waits for the response character to
be received after every line is transmitted before sending the next
line, slowing transmission.
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• Flow controls—If either Measure or the instrument has to pause
data flow, transmission is slowed.

• Delay—The number of seconds added to the transmission after
each end-of-line. The effect that a delay has on transmission
throughput is a function of the number of lines of data that you are
transmitting. Because delay works by delaying lines sent, the more
lines that are sent, the more impact the delay has on throughput.

• Lag—The number of milliseconds the Serial Add-In is instructed
to wait after each character is transmitted.
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Serial Connector Pinouts

This appendix lists the pin assignments of common serial connectors.
Notice that many instruments do not use all the pins. Also, many
instruments have different pin assignments. Consult your instrument’s
documentation for the correct pin assignments.

Pin Assignments For the 9-Pin RS-232 Connector
Generally Used on PCs

Pin Function

1 Data Carrier Detect (DCD)

2 Received Data (RxD)

3 Transmit Data (TxD)

4 Data Terminal Ready (DTR)

5 Common (Must be connected)

6 Data Set Ready (DSR)

7 Request to Send (RTS)

8 Clear to Send (CTS)

9 Ring Indicator
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Relevant Pin Assignments For a 25-pin RS-232
Connector

Pin Function

2 Transmit Data (TxD)

3 Received Data (RxD)

4 Request to Send (RTS)

5 Clear to Send (CTS)

6 Data Set Ready (DSR)

7 Common (Must be connected)

8 Data Carrier Detect (DCD)

20 Data Terminal Ready (DTR)
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Error Messages

This appendix describes the errors that can be encountered while using
the Serial Add-In.

Communications Errors

The errors described in the following table can occur at any time while
communicating with the instrument. When using VBA, the function
GetMeasureError  returns these error messages. Notice that the
first column of the table contains the bit in base 10. For more
information about this function, see Chapter 4, Using Measure Serial
Tasks with VBA.

Table B-1. Communication Return Values

Return
Value

Error Description

1 CE_RXOVER Input buffer overflow. This error occurs when the input
buffer is full, and the device is sending data faster than it
can be parsed and stored. Using flow control prevents input
buffer overflow.

2 CE_OVERRUN Input buffer overflow. This error occurs when a
transmission rate is too fast. The next character from a
device arrived before the previous character has been taken
from the asynchronous port register and been placed in the
buffer. Occasionally this error is caused by a baud rate
setting that does not match the baud rate of the device.
Check the documentation of the device to be sure you are
using the correct baud rate.

4 CE_RXPARITY Hardware detected a parity error. This could be caused by a
genuine parity error, or by a parity setting that does not
match the parity of the device. Check the documentation of
the device and enter the correct setting.
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8 CE_FRAME A framing error occurred. This occurs when synchronization
fails on a serial link.

16 CE_BREAK Hardware detected a break condition.

32 CE_CTSTO Timeout occurred while waiting for the CTS (clear-to-send)
signal.

64 CE_DSRTO Timeout occurred while waiting for the DSR (data-set-ready)
signal.

128 CE_RLSDTO RLSD (receive-line-signal-detect) timeout.

256 CE_TXFULL The transmission queue was full when a function attempted to
queue a character.

512 CE_PTO A timeout occurred during an attempt to communicate with a
parallel device.

1024 CE_IOE I/O error on a parallel device.

2048 CE_DNS Parallel device was not selected.

4096 CE_OOP Out of paper on a parallel device.

32768 CE_MODE A requested device mode is not available.

Errors Encountered While Opening an Instrument

The errors described in the following table can occur when an
instrument is opened. When using VBA, the function
GetMeasureError  returns these error messages. For more
information about this function, see Chapter 4, Using Measure Serial
Tasks with VBA.

Table B-2. Open Instrument Return Values

Return
Value

Error Description

-1 IE_BADID Invalid device identifier.

-2 IE_OPEN The device is already open.

-3 IE_NOPEN The device cannot be opened.

-4 IE_MEMORY Insufficient memory for input and output buffers.

-5 IE_DEFAULT The default parameters are invalid.

-10 IE_HARDWARE The device is not available.
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-11 IE_BYTESIZE The byte size is invalid.

-12 IE_BAUDRATE Invalid baud rate.

Measure VBA Errors

Calls to the VBA functions RunTask , CloseInstrument ,
FlushInputBuffer , FlushOutputBuffer ,
GetInputBufferLength , and GetOutputBufferLength
return one of the values contained in the following table. For more
information about these functions, refer to Chapter 4, Using Measure
Serial Tasks with VBA.

Table B-3. Measure VBA Return Values

Return
Value

Error Description

0 MEASURE_OK The command completed successfully

-1000 MEASURE_NOTFOUND The given task or instrument was not
found.

-1001 MEASURE_INVALIDRANGE The given range is invalid.

-1002 MEASURE_TIMEDOUT The task timed out while waiting for
data from the instrument.

-1003 MEASURE_INTERRUPTED The user interrupted the task.

-1004 MEASURE_PARITYERROR A parity error occurred.

-1005 MEASURE_ERROR An communications error occurred
while communicating with the
instrument. Call GetMeasureError
to determine the error.

-1006 MEASURE_OPENERROR An error occurred while opening the
instrument. Call
GetMeasureOpenError  to
determine the error.

-1007 MEASURE_INSTRUMENTNOTOPENThe specified instrument is not open.
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Troubleshooting

This appendix provides help for some common problems encountered
when working with serial instruments.

When Measure does not control the instrument correctly, use the Test
dialog box as outlined below.

1. Select Serial»Instruments.

2.  Select the correct instrument in the Instruments list box.

3.  Click on the Test button to display the Instrument Test dialog
box.

The steps to take next depend on the instrument you are using. Look
through the manual for your instrument and find a command string that
the instrument responds to. For instance, the Fluke 45 multimeter
accepts the command val1?\13  and returns the value of the
multimeter. The Ohaus scale accepts the command P\13  and responds
with a 20 character record containing the current weight.

To test the Fluke 45, complete the following steps.

1.  Type val1?\13  in the Transmit edit box.

2.  Click on Send Data. If nothing appears in the Receive edit box,
try clicking on Read Serial Port. If nothing appears in the
Receive edit box, make sure the string you typed is recognized by
the instrument. Be sensitive to case, for instance the command
P\13  may be correct, while p\13  may not. Some instruments
respond with an error string when they receive incorrect
commands, while other instruments simply ignore unknown
commands. If you are certain the instrument should respond to the
string you typed, follow the steps below to help diagnose the
problem.
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Testing the Serial Port

One way to test a serial port is to disconnect the instrument and connect
pins two and three from the serial port together. To do this test,
complete the following steps.

1.  Select Serial»Instruments. Click on New to create a new
instrument.

2.  Select the correct communications port and set the flow control
field to None. Leave the other communications fields at their
defaults.

3.  Click on Test to display the Test Instrument dialog box. If you get
an error, refer to the section below discussing what to do when this
test fails. Otherwise, when the Test Instrument dialog box appears,
type a few letters in the Transmit edit box, and click on the Send
Data button. If all the parameters are set up correctly, the string
you typed should appear in the Receive edit box. Notice that some
characters in the Receive edit box might be printed as escape
sequences. For example, space prints as \32 , and Enter prints as
\13\10 .

If the string you typed appeared in the Receive edit box, one of the
following problems is most likely the cause.

1. The cable is incorrectly wired or there is a loose connection. This
is by far the most common problem encountered when working
with serial instruments. Refer to the instructions that came with
your instrument and the table of serial connector pinouts in this
manual to correctly connect the instrument to the computer.

2. Flow control is set incorrectly, or the required flow control pins
between the instrument and the computer are not connected
correctly. Instruments vary widely in their use of flow control.
Refer to the instructions that came with your instrument to
determine which pins are used for flow control.

3. Parity, baud rate, data bits, or stop bits is set incorrectly. The
instructions that came with your instrument should list the
communications parameters that your instrument uses. The
required parameters may be listed in the form 2400-O-7-1,
meaning 2400 baud, odd parity, 7 data bits, and 1 stop bit.
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If the string you typed did not appear in the Receive edit box, one of
the following problems is likely the cause.

1. The communications port (com port) setting in Measure is
incorrect or the com port is configured incorrectly in Windows. It
is likely that you got the message, Unable to open com
port X, the device is not available . Many
computers have two serial (com) ports, accessed as com 1 and
com 2. Under Microsoft Windows, the address and interrupt
associated with each com port must be defined before the ports are
used.

 To configure a com port in Windows, complete the following
steps.

a.  Close Excel, find the Control Panel icon, and double-click on
it.

b.  Find the Ports icon and double-click on it.

c.  If the port you want to use is not defined, click on the Add
button to add a new port. Common settings for com 1 are: I/O
Address: 3f8, IRQ: 4. Common settings for com 2 are: I/O
Address: 2f8, IRQ: 3.

d.  If the port you want to use is defined, select the correct port
and click on the Settings button, then click on the Advanced
button. Refer to the common settings for com 1 and com 2
above to determine if your com ports are configured correctly.

2.  If you get the message Unable to open com port X,
the device cannot be opened , the com port you
selected is in use by another program.

In this situation, try the following steps until the problem is
resolved.

a.  Close all other applications in Windows and try the test again.

b.  If closing all other applications does not work, try closing and
restarting Excel.

c.  If restarting Excel still does not work, try quitting and
restarting Windows.
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Customer Communication

For your convenience, this appendix contains forms to help you gather the information necessary
to help us solve technical problems you might have as well as a form you can use to comment on
the product documentation. Filling out a copy of the Technical Support Form before contacting
National Instruments helps us help you better and faster.

National Instruments provides comprehensive technical assistance around the world. In the U.S.
and Canada, applications engineers are available Monday through Friday from 8:00 a.m. to
6:00 p.m. (central time). In other countries, contact the nearest branch office. You may fax
questions to us at any time.

Electronic Services

Bulletin Board Support

National Instruments has BBS and FTP sites dedicated for 24-hour support with a collection of
files and documents to answer most common customer questions. From these sites, you can also
download the latest instrument drivers, updates, and example programs. For recorded instructions
on how to use the bulletin board and FTP services and for BBS automated information, call
(512) 795-6990. You can access these services at:

United States: (512) 794-5422 or (800) 327-3077
Up to 14,400 baud, 8 data bits, 1 stop bit, no parity

United Kingdom: 01635 551422
Up to 9,600 baud, 8 data bits, 1 stop bit, no parity

France: 1 48 65 15 59
Up to 9,600 baud, 8 data bits, 1 stop bit, no parity

FTP Support

To access our FTP site, log on to our Internet host, ftp.natinst.com , as anonymous and use
your Internet address, such as joesmith@anywhere.com , as your password. The support files
and documents are located in the /support directories.
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FaxBack Support

FaxBack is a 24-hour information retrieval system containing a library of documents on a wide
range of technical information. You can access FaxBack from a touch-tone telephone at the
following number:

(512)  418-1111

E-Mail Support (currently U.S. only)

You can submit technical support questions to the appropriate applications engineering team
through e-mail at the Internet addresses listed below. Remember to include your name, address,
and phone number so we can contact you with solutions and suggestions.
MEASURE: measure.support@natinst.com DAQ: daq.support@natinst.com
GPIB: gpib.support@natinst.com

Fax and Telephone Support
National Instruments has branch offices all over the world. Use the list below to find the technical
support number for your country. If there is no National Instruments office in your country,
contact the source from which you purchased your software to obtain support.

Telephone Fax
Australia 03 9 879 9422 03 9 879 9179
Austria 0662 45 79 90 0 0662 45 79 90 19
Belgium 02 757 00 20 02 757 03 11
Canada (Ontario) 519 622 9310
Canada (Quebec) 514 694 8521 514 694 4399
Denmark 45 76 26 00 45 76 26 02
Finland 90 527 2321 90 502 2930
France 1 48 14 24 24 1 48 14 24 14
Germany 089 741 31 30 089 714 60 35
Hong Kong 2645 3186 2686 8505
Italy 02 413091 02 41309215
Japan 03 5472 2970 03 5472 2977
Korea 02 596 7456 02 596 7455
Mexico 95 800 010 0793 5 520 3282
Netherlands 0348 433466 0348 430673
Norway 32 84 84 00 32 84 86 00
Singapore 2265886 2265887
Spain 91 640 0085 91 640 0533
Sweden 08 730 49 70 08 730 43 70
Switzerland 056 200 51 51 056 200 51 55
Taiwan 02 377 1200 02 737 4644
U.K. 01635 523545 01635 523154



Technical Support Form
Photocopy this form and update it each time you make changes to your software or hardware, and
use the completed copy of this form as a reference for your current configuration. Completing this
form accurately before contacting National Instruments for technical support helps our
applications engineers answer your questions more efficiently.

If you are using any National Instruments hardware or software products related to this problem,
include the configuration forms from their user manuals. Include additional pages if necessary.

Name                                                                                                                                                  

Company                                                                                                                                             

Address                                                                                                                                             

                                                                                                                                                              

Fax (         )                                                         Phone (         )                                                       

Computer brand                                     Model                              Processor                              

Operating system: Windows 3.1, Windows for Workgroups 3.11, Windows NT 3.1,
Windows NT 3.5, Windows 95, other (include version number)                                                        

Version of Excel (look at Excel’s About box): 5.0, 5.0c, other                                                           

Clock Speed                     MHz RAM                  MB Display adapter                                  

Mouse            yes              no Other adapters installed                                                         

Hard disk capacity              MB Brand                                                                                       

Instruments used                                                                                                                                

National Instruments hardware product model                                     Revision                       

Configuration                                                                                                                                      

National Instruments software product                                                Version                         

Configuration                                                                                                                                      

The problem is                                                                                                                                    

                                                                                                                                                              

                                                                                                                                                              

                                                                                                                                                              

List any error messages                                                                                                                      

                                                                                                                                                              

                                                                                                                                                              

                                                                                                                                                              

The following steps will reproduce the problem                                                                                

                                                                                                                                                              

                                                                                                                                                              



Hardware and Software Configuration Form
Record the settings and revisions of your hardware and software on the line to the right of each
item. Complete a new copy of this form each time you revise your software or hardware
configuration, and use this form as a reference for your current configuration. Completing this
form accurately before contacting National Instruments for technical support helps our
applications engineers answer your questions more efficiently.

National Instruments Products
Serial Hardware Revision _________________________________________________________

Interrupt Level of Hardware _______________________________________________________

DMA Channels of Hardware ______________________________________________________

Base I/O Address of Hardware _____________________________________________________

COM Driver Version ____________________________________________________________

Other Products
Computer Make and Model _______________________________________________________

Microprocessor _________________________________________________________________

Clock Frequency ________________________________________________________________

Type of Video Board Installed _____________________________________________________

Operating System _______________________________________________________________

Operating System Version ________________________________________________________

Operating System Mode __________________________________________________________

Programming Language __________________________________________________________

Programming Language Version ___________________________________________________

Other Boards in System __________________________________________________________

Base I/O Address of Other Boards __________________________________________________

DMA Channels of Other Boards ___________________________________________________

Interrupt Level of Other Boards ____________________________________________________



For each instrument you are using:

Name of instrument ______________________________________________________________

Manufacturer of instrument ________________________________________________________

Parity: None, Even, Odd, Mark, Space

Baud rate ______________________________________________________________________

Stop bits _______________________________________________________________________

Data bits_______________________________________________________________________

Flow control: Hardware, Software, None

Version of Measure: (look at the about box) ___________________________________________



Documentation Comment Form
National Instruments encourages you to comment on the documentation supplied with our
products. This information helps us provide quality products to meet your needs.

Title: Measure® Serial Control User Manual

Edition Date: August 1996

Part Number: 321005B-01

Please comment on the completeness, clarity, and organization of the manual.

                                                                                                                                                              

                                                                                                                                                              

                                                                                                                                                              

                                                                                                                                                              

                                                                                                                                                              

                                                                                                                                                              

                                                                                                                                                              
If you find errors in the manual, please record the page numbers and describe the errors.

                                                                                                                                                              

                                                                                                                                                              

                                                                                                                                                              

                                                                                                                                                              

                                                                                                                                                              

                                                                                                                                                              

                                                                                                                                                              
Thank you for your help.

Name                                                                                                                                                  

Title                                                                                                                                                    

Company                                                                                                                                             

Address                                                                                                                                               

                                                                                                                                                              

Phone (              )                                                                                                                                

Mail to: Technical Publications Fax to: Technical Publications
National Instruments Corporation National Instruments Corporation
6504 Bridge Point Parkway (512) 794-5678
Austin, TX 78730-5039
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Prefix Meaning Value

p-

n-

µ-

m-

k-

M-

pico-

nano-

micro-

milli-

kilo-

mega-

10-12

10-9

10-6

10-3

103

106

A

Add-In A software package designed to integrate into Microsoft Excel.

Asynchronous A method of data communications in which information is
transmitted one character at a time. A start bit precedes each
character and a stop bit follows each character. The start bit
signals the beginning of the character transmission and the stop
bit indicates its completion. The Serial Add-In uses
asynchronous communications in its data exchanges.

B

Baud Rate The transmission rate of characters expressed in bits per second.
Since there are additional bits transmitted -- for example, stop
bits -- the baud rate divided by ten is the approximate number of
characters transmitted per second. For instance, 9600 baud is
roughly equivalent to 960 characters / second.

Bit A single value of 1 or 0. A byte consists of 8 bits.
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Break A signal sent to interrupt a remote device, usually to make the
device stop processing and respond.

Byte The standard method of representing numbers or characters in
computers. Eight binary digits (bits) make up a byte.

C

Capture Task A task used to retrieve data from an instrument and store it in a
range in the Excel worksheet.

Command String A string sent to an instrument.

D

Delay Delay is the extra time that may be allotted to devices that are
slow in responding to and processing an ongoing line. Usually,
the extra time allows the device to respond to the line as a
command.

E

Escape Sequence A special string used to represent an unprintable character. For
example, "\10" is the escape sequence for a linefeed character.

F

Field A field is a division of a line of data. Lines are separated into
fields using one of the Serial Add-In parsing techniques.

Flow Control See Handshaking.

H

Handshaking Handshaking is an agreed-upon standard used to facilitate two-
way communications. In the Serial Add-In, software or
hardware handshaking can be used. Handshaking allows a
device to request that data transmission be paused when no more
data can be accepted or resumed when the device is ready to
receive more data.
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I

Instrument In Measure, a name given to information about the serial port
settings of a real instrument.

L

Lag Lag is the time between characters transmitted from the Serial
Add-In to an instrument.

Line A line is a unit of data demarcated by end-of-line strings. A line
of data generally corresponds to a row of a transmit or capture
range.

M

MB megabytes of memory

P

Parallel Data Transmission A form of data transmission in which information is sent as an
entire character or byte at a time. See Serial Data Transmission.

Parity A type of error-checking used in data transmission. The parity of
two communicating devices must match.

Parse Parsing consists of breaking up lines of data into smaller, more
manageable units, called fields. In the Serial Add-In, you can
parse a line of data based on width or using delimiters.

R

Range A group of rows and columns on a spreadsheet.

Response When capturing data from an instrument, the response is the
character that Measure sends to the instrument after every line is
received. When transmitting data to an instrument, the response
is the character that Measure waits for from the instrument
before sending another line of data.
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RS-232 Protocol A widely used standard for serial, asynchronous
communications between a modem or other Data
Communications Equipment (DCE) and associated Data
Terminal Equipment (DTE). The standard has been developed
by the Electronic Industries Association (EIA) and various
manufacturers and users. The RS-232 protocol is present in the
IBM PC hardware in the form of an asynchronous interface, or
serial (COM) port.

S

Serial Data Transmission A form of data transmission in which information is sent one bit
at a time. The Serial Add-In is a serial communications
interface. See Parallel Data Transmission.

Start Bit In asynchronous serial communications, the bit that signals the
beginning of a character transmission.

Stop Bit In asynchronous serial communications, the bit that signals the
end of a character transmission.

Synchronous A method of data communications in which a prearranged
number of bits are transferred per second. Synchronization
occurs before and after the transmission of blocks of data, rather
than before and after every character. There are no start bits or
stop bits, as there are in asynchronous communications.
Transmitted bits either represent information or are parity bits.
See Asynchronous.

T

Transmission Task A task used to send data from an Excel worksheet to an
instrument.

V

Visual Basic for The programming language built into Microsoft
Applications (VBA) Excel.
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A
adding Serial Add-In manually, 1-1 to 1-2
adding tasks to Serial menu, 2-11 to 2-12
Advanced Instrument Setup dialog box, 3-4

to 3-6
Buffer Sizes, 3-6
Flow Control Points, 3-5
illustration, 3-5
Input Signals, 3-5
Lag, 3-6
Output Signals, 3-5
Parity Error Character, 3-6
Software Control, 3-5

Advanced Setup option, Serial Instrument
Setup dialog box, 3-3

ASCII values, entering, 2-12

B
backslash (character for entering ASCII

values), 2-12
baud rate

and character format, 5-2 to 5-3
calculating throughput, 5-2 to 5-3

Baud Rate option, 3-2
Break on parity errors option

Capture Task dialog box, 3-9
Transmission Task dialog box, 3-11

Buffer Sizes option, 3-6
bulletin board support, D-1

C
Capture Task dialog box

Fluke 45 Multimeter example, 2-8, 2-9
illustration, 3-8
serial task reference, 3-8 to 3-10

Break on parity errors, 3-9
Clear input buffer, 3-9
Command string, 3-9
Define Fields, 3-10
Delay, 3-10
Description, 3-9
Display status, 3-9
End-of-line string, 3-9
Response string, 3-10
Result range, 3-9
Task Name, 3-9
Timeout, 3-9

capture tasks
creating

instrument capture task, 2-7 to 2-8
instrument read task, 2-9
procedure for, 2-4

fields
parsing by custom-defined delimiters,

2-5
parsing by default delimiter, 2-6
parsing by width, 2-6
purpose, 2-5

purpose, 2-4
character bits format, 5-2
Clear input buffer option
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Capture Task dialog box, 3-9
Transmission Task dialog box, 3-11

Close Instrument option, 3-7
CloseInstrument function, 4-3
closing serial port, 5-1
Com Port option, 3-2
Command String option

Capture Task dialog box, 3-9
Transmission Task dialog box, 3-11

communications errors, B-1 to B-2
communications strings, 2-12
creating tasks. See tasks.
customer communication, xi, D-1 to D-2

D
Data Bits option, 3-2
Default Delimiters option, 3-13
Define Fields dialog box, 3-12 to 3-13

Default Delimiters, 3-13
Field: Delimiter, 3-13
Field: Width, 3-13
illustration, 3-12
Include, 3-13
List Box, 3-13
Number of Fields, 3-13
Parsing Method: Delimiters, 3-13
Parsing Method: Width, 3-13

Define Fields option, Capture Task dialog
box, 3-10

delay, and throughput rate, 5-3
Delay option

Capture Task dialog box, 3-10
Transmission Task dialog box, 3-12

Delete button
Serial Instrument Setup dialog box, 3-2
Tasks dialog box, 3-8

delimiters. See also Define Fields dialog
box.

parsing fields by custom-defined
delimiters, 2-5

parsing fields by default delimiter, 2-6
Description field

Capture Task dialog box, 3-9

Tasks dialog box, 3-8
Transmission Task dialog box, 3-11

Display status option
Capture Task dialog box, 3-9
Transmission Task dialog box, 3-11

documentation
conventions used in manual, x
organization of manual, ix-x
related documentation, xi

E
Edit button, 3-8
Edit Instruments option, 3-7
Edit Menu button, 3-8
e-mail support, D-2
End-of-line string, and throughput rate, 5-2
End-of-line String option

Capture Task dialog box, 3-9
Transmission Task dialog box, 3-11

errors
communications errors, B-1 to B-2
encountered while opening instruments

(table), B-2

F
fax and telephone support, D-2
FaxBack support, D-2
Field: Delimiter option, 3-13
Field: Width option, 3-13
fields. See also Define Fields dialog box.

parsing
by custom-defined delimiters, 2-5
by width, 2-6
using default delimiter, 2-6

purpose and use, 2-5
Flow Control option

Advanced Instrument Setup dialog box,
3-5

Serial Instrument Setup dialog box, 3-2 to
3-3

flow controls, and throughput rate, 5-3
Fluke 45 Multimeter examples
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configuration task, 2-2
creating capture task, 2-7 to 2-8
creating instrument read task, 2-9
running serial task, 2-10 to 2-11
testing instrument connection, 2-3

FlushInputBuffer function, 4-3
FlushOutputBuffer function, 4-4
FTP support, D-1
functions. See Visual Basic for Applications

(VBA).

G
GetInputBufferLength function, 4-4
GetMeasureError function, 4-5
GetMeasureOpenError function, 4-5
GetOutputBufferLength function, 4-6

I
Include option, Define Fields dialog box,

3-13
Input Signals option, 3-5
installation

adding Serial Add-In manually, 1-1 to 1-2
Measure for Windows, 1-1
removing Serial Add-In manually, 1-1 to

1-2
uninstalling Measure, 1-2

Instrument list box, 3-7
Instrument Setup dialog box. See Serial

Instrument Setup dialog box.
Instrument Test dialog box

Fluke 45 Multimeter example, 2-3
illustration, 3-3
serial task reference, 3-3 to 3-4

Read Serial Port, 3-4
Receive edit box, 3-4
Send Data, 3-4
Transmit edit box, 3-4

instruments
configuring instrument (example), 2-2
create instrument capture task, 2-7 to 2-8
create instrument read task, 2-9

definition, 2-1
errors encountered while opening (table),

B-2
testing the instrument connection

(example), 2-3

L
lag, and throughput rate, 5-3
Lag option, 3-6

M
manual. See documentation.
Measure Serial Add-In. See also Visual

Basic for Applications (VBA).
adding Serial Add-In manually, 1-1 to 1-2
communications strings, 2-12
overview, 2-1
removing Serial Add-In manually, 1-1 to

1-2

N
New Capture button, Tasks dialog box, 2-4,

3-7
New option, Serial Instrument Setup dialog

box, 3-2
New Transmit button, Tasks dialog box,

2-4, 3-8
nonprinting characters, entering, 2-12
Number of Fields option, 3-13

O
Output Signals option, 3-5

P
parity bit format, 5-2
Parity Error Character option, 3-6
Parity option, 3-2
parsing fields

by custom-defined delimiters, 2-5
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by width, 2-6
using default delimiter, 2-6

Parsing Method: Delimiters option, 3-13
Parsing Method: Width option, 3-13
pinouts for serial connector

9-pin RS-232 connector generally used on
PCs, A-1

relevant pin assignments for 25-pin
RS-232 connector, A-2

R
Read Serial Port option, 3-4
read task, creating, 2-9 to 2-10
Receive edit box, 3-4
reference, adding to Serial Add-In, 4-1 to

4-2
removing Serial Add-In manually, 1-1 to

1-2
Repeat Count option, 3-11
response character, and throughput rate, 5-2
Response String option

Capture Task dialog box, 3-10
Transmission Task dialog box, 3-12

Result range option, 3-9
return values, for Measure VBA (table), B-3
Run option, 3-8
running tasks, 2-10 to 2-11

S
Send Data button, Instrument Test dialog

box, 3-4
Serial Add-In. See Measure Serial Add-In.
serial connector pinouts

9-pin RS-232 connector generally used on
PCs, A-1

relevant pin assignments for 25-pin
RS-232 connector, A-2

Serial function, 4-6 to 4-7
Serial Instrument Setup dialog box

Fluke 45 Multimeter example, 2-2
illustration, 2-2, 3-1
serial task reference, 3-1 to 3-3

Advanced Setup, 3-3
Baud Rate, 3-2
Com Port, 3-2
Data Bits, 3-2
Delete, 3-2
Flow Control, 3-2 to 3-3
New, 3-2
Parity, 3-2
Stop Bits, 3-2
Test, 3-2

Serial menu
adding tasks, 2-11 to 2-12
Instruments, 2-1
Tasks, 2-4

serial port
closing, 5-1
testing, C-2 to C-3

serial task reference
Advanced Instrument Setup dialog box,

3-4 to 3-6
Buffer Sizes, 3-6
Flow Control Points, 3-5
Input Signals, 3-5
Lag, 3-6
Output Signals, 3-5
Parity Error Character, 3-6
Software Control, 3-5

Capture Task dialog box, 3-8 to 3-10
Break on parity errors, 3-9
Clear input buffer, 3-9
Command string, 3-9
Define Fields, 3-10
Delay, 3-10
Description, 3-9
Display status, 3-9
End-of-line string, 3-9
Response string, 3-10
Result range, 3-9
Task Name, 3-9
Timeout, 3-9

Define Fields dialog box, 3-12 to 3-13
Default Delimiters, 3-13
Field: Delimiter, 3-13
Field: Width, 3-13
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Include, 3-13
List Box, 3-13
Number of Fields, 3-13
Parsing Method: Delimiters, 3-13
Parsing Method: Width, 3-13

Instrument Test dialog box, 3-3 to 3-4
Read Serial Port, 3-4
Receive edit box, 3-4
Send Data, 3-4
Transmit edit box, 3-4

Serial Instrument Setup dialog box, 3-1 to
3-3

Advanced Setup, 3-3
Baud Rate, 3-2
Com Port, 3-2
Data Bits, 3-2
Delete, 3-2
Flow Control, 3-2 to 3-3
New, 3-2
Parity, 3-2
Stop Bits, 3-2
Test, 3-2

Tasks dialog box, 3-6 to 3-8
Close Instrument, 3-7
Delete, 3-8
Description, 3-8
Edit, 3-8
Edit Instruments, 3-7
Edit Menu, 3-8
Instrument list box, 3-7
New Capture, 3-7
New Transmit, 3-7
Run, 3-8
Tasks list box, 3-7

Transmission Task dialog box, 3-10 to
3-12

Break on parity errors, 3-11
Clear input buffer, 3-11
Command String, 3-11
Delay, 3-12
Description, 3-11
Display status, 3-11
End-of-line String, 3-11
Repeat Count, 3-11

Response String, 3-12
Task Name, 3-11
Timeout, 3-11
Transmission Range, 3-11

serial tasks. See tasks.
Software Control option, 3-5
start bit format, 5-2
stop bits format, 5-2
Stop Bits option, 3-2
strings, specifying in communications, 2-12

T
Task Name option

Capture Task dialog box, 3-9
Transmission Task dialog box, 3-11

tasks
adding to Serial menu, 2-11 to 2-12
capture tasks

parsing fields, 2-5 to 2-6
purpose, 2-4
steps in procedure, 2-4

creating
instrument capture task, 2-7 to 2-8
instrument read task, 2-9

definition, 2-4
Fluke 45 Multimeter examples. See

Fluke 45 Multimeter examples.
running, 2-10 to 2-11
transmission tasks

definition, 2-7
steps in task, 2-7

Tasks dialog box, 2-4
illustration, 3-7
running tasks from, 2-10 to 2-11
serial task reference, 3-6 to 3-8

Close Instrument, 3-7
Delete, 3-8
Description, 3-8
Edit, 3-8
Edit Instruments, 3-7
Edit Menu, 3-8
Instrument list box, 3-7
New Capture, 3-7
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New Transmit, 3-7
Run, 3-8
Tasks list box, 3-7
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testing

instrument connection, 2-3
serial port, C-2 to C-3

time delay, 5-1
Timeout option

Capture Task dialog box, 3-9
Transmission Task dialog box, 3-11

Transmission Range option, 3-11
Transmission Task dialog box, 3-10 to 3-12

Break on parity errors, 3-11
Clear input buffer, 3-11
Command String, 3-11
Delay, 3-12
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Display status, 3-11
End-of-line String, 3-11
illustration, 3-10
Repeat Count, 3-11
Response String, 3-12
Task Name, 3-11
Timeout, 3-11
Transmission Range, 3-11

transmission tasks
definition, 2-7
steps in task, 2-7

Transmit edit box, 3-4
troubleshooting, C-1 to C-3

U
uninstalling Measure, 1-2

V
Visual Basic for Applications (VBA)

calling functions from VBA, 4-1 to 4-2
Serial Add-In functions

CloseInstrument, 4-3
FlushInputBuffer, 4-3
FlushOutputBuffer, 4-4
GetInputBufferLength, 4-4
GetMeasureError, 4-5
GetMeasureOpenError, 4-5
GetOutputBufferLength, 4-6
Serial, 4-6 to 4-7
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